
Bruce McGaw Art Browser 1.0

How To ...
Create a New Image Search
Edit an Existing Image Search
Create a New Slide Show

            Create an Order
            Print an Order

Commands
File menu
Edit menu
Image Search menu
Slide Show menu
Order menu
Help menu

Views
Thumbnail Screen
Poster Information Screen
Full Screen Image
Shopping Cart Screen



File menu commands

The File menu offers the following commands:

New Image Search Creates a new Image Search.

Open Image Search Opens an existing Image Search.

Save Image Search Saves an opened Image Search using the same file name.

Save Image Search As Saves an opened Image Search to a specified file name.

Open Slide Show Open and existing Slide Show

Save Order As Slide Show Save Order as a Slide Show

Print Prints a document.

Print Preview Displays the document on the screen as it would appear 
printed.

Print Setup Selects a printer and printer connection.

Exit Exits Image Search.



Edit menu commands

The Edit menu offers the following commands:

Back Use the Back command to go back to view the previous image, or in the case of thumbnails, to 
view the preceding set of images.

Next Use the Next command to go forward to view the next image, or in the case of thumbnails, to 
view the next set of images. 

Home Use the Home command to return to the Bruce McGaw Graphics start screen.
 

Cut Deletes data from the document and moves it to the clipboard.

Copy Copies data from the document to the clipboard.

Paste Pastes data from the clipboard into the document.

Preferences Allows changes to pricing, international measurements and personal information

Registration 
Wizard

Enables parameter set-up and allows Bruce McGaw Graphics the ability to notify you of 
changes to the software and the latest updates.



Image Search menu commands

The Image Search menu offers the following commands, which allow for the definition of selection criteria 
to quickly and easily filter only the desired images from the Bruce McGaw Graphics 

New Image Search Create new Image Search. 

Open Image Search Allows the retrieval of a previously saved 
Image Search.

Edit Current Image Search Edit the current Image Search.
 

Save Image Search Saves the Image Search to a file.

Save Image Search As Saves the Image Search to a different file 
name.



Slide Show menu commands

The Slide Show menu

Open Slide Show Open and existing Slide Show

Save Order As Slide Show Save Order as a Slide Show

Run Slide Show Run Slide Show

Stop Slide Show Stop running Slide Show



Order menu commands

The Order menu

Add Item To Order Add this item to your Order

Shopping Cart Show your current Order



Help menu commands

The Help menu offers the following commands, which provide you assistance with this application: 

Index Offers you an index to topics on which you can get help.

Using 
Help

Provides general instructions on using help.

About Displays the version number of this application.



File Open dialog box

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

Drives
Select the drive in which Image Search stores the file that you want to open. 

Directories
Select the directory in which Image Search stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a document with a different name.    A filename can contain up to eight 
characters and an extension of up to three characters.    Image Search adds the extension you 
specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

<< Add other File Save As dialog box options depending on which ones your application chooses via the 
OFN_ flags of the OPENFILENAME structure used by the CFileDialog. >>



Exit command (File menu)

Use this command to end your Image Search session.    You can also use the Close command on the 
application Control menu.    Image Search prompts you to save documents with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Back command (Edit menu)

Use the Back command to go back to view the previous image, or in the case of thumbnails, to view the 
preceding set of images.



Next command (Edit menu)

Use the Next command to go forward to view the next image, or in the case of thumbnails, to view the 
next set of images. 



Home command (Edit menu)

Use the Home command to return to the Bruce McGaw Graphics start screen. 



Cut command (Edit menu)

Use this command to remove the currently selected data from the document and put it on the clipboard.    
This command is unavailable if there is no data currently selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+X



Copy command (Edit menu)

Use this command to copy selected data onto the clipboard.    This command is unavailable if there is no 
data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts
Keys: CTRL+C



Paste command (Edit menu)

Use this command to insert a copy of the clipboard contents at the insertion point.    This command is 
unavailable if the clipboard is empty.

Shortcuts
Keys: CTRL+V



Registration Wizard

Enables parameter set-up and allows Bruce McGaw Graphics the ability to notify you of changes to the 
software and the latest updates.



Understanding The Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The toolbar 
provides quick mouse access to many tools used in Image Search,

Click To

Use the Back Button to go back to view the previous image, or in the case of thumbnails, 
to view the preceding set of images or image.

Use the Forward Button to go forward to view the next image, or in the case of 
thumbnails, to view the next set of images image.

Use the Home Button to return to the Bruce McGaw Graphics start screen.

The Search Button starts an Image Search by bringing up the Image Search dialog.    It 
will continue with the currently active Image Search.

The Slide Show Button brings up the select Slide Show dialog.    If a Slide Show is 
currently active, the Slide Show will start when the button is clicked.

Use the Add Button to add the current image to the Shopping Cart.    This choice is only 
available from the Image Information screen.

Use the Shopping Cart Button to bring up the Shopping Cart Dialog if an order has been 
started. 

Use the Help Button to bring up context sensitive help screens.



New Search (Image Search menu)

Use this command to define criteria for selecting a subset of posters from the Bruce McGaw Graphics 
catalog.    Image Search allows selection based on any combination of Category/Style, Color, Artist, Size 
or Subject.    These searches can then be saved to a file for later use. 



Open Image Search

Use this command to open a previously saved image search

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

Drives
Select the drive in which Image Search stores the file that you want to open. 

Directories
Select the directory in which Image Search stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Save Image Search

Saves an opened Image Search using the same file name, or the default file name.



Save Image Search As

Saves an opened Image Search to a specified file name.



Edit Current Search (Image Search menu)

Use this command to change or redefine criteria for selecting a subset of posters from the Bruce McGaw 
Graphics catalog.    Image Search allows selection based on any combination of Category/Style, Color, 
Artist, Size or Subject.    These searches can then be saved to a file for later use. 



Open Slide Show

Use this command to open a previously saved slide show.

The following options allow you to specify which file to open:

File Name
Type or select the filename you want to open.    This box lists files with the extension you select in the 
List Files of Type box. 

Drives
Select the drive in which Image Search stores the file that you want to open. 

Directories
Select the directory in which Image Search stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter if necessary. 



Save Order As Slide Show

Type a file name to save an order as a slide show in the space provided for file name. 



Run Slide Show

Starts selected slide show after first opening the slide show.



Stop Slide Show

Stops slide show.    A slide show can be stopped also clicking the mouse.



Image Search

An Image Search is an easy way to find and view posters from the Bruce McGaw Graphics catalog. 
Essentially, it filters through the thousands of images contained in the catalog.    It is specifically designed 
to help find either a specific poster or a group of posters through choices based on any combination of 
Category/Style, Color, Artist, Size or Subject.    The results of these searches can viewed at any time or 
saved as a file for future reference. Any previously saved Image Search file can be reactivated and edited 
through the Image Search dialog.



Slide Show

A Slide Show is a method of viewing a pre-selected collection of full screen images on a black 
background.    The images can be selected by using the Image Search commands and creating an order. 
The order is then saved as a slide show. 



Order

This command allows the editing and viewing of user selected images.    The order can be refined by 
using the edit button and the final order form can be printed either from the button on the right side of the 
screen or from the file print order menu selection on the top of the screen.    The order form once printed 
can be completed by the user and faxed to Bruce McGaw Graphics for processing.



Add Item to Order    (Order menu)

Use this command to add the current image to the Shopping Cart.    This choice is only available from the 
Image Information screen 



How to Create a New Image Search

An Image Search is an easy way to find and view posters from the Bruce McGaw Graphics catalog.    
Essentially, it filters through the thousands of images contained in the catalog.    It is specifically designed 
to help find either a specific poster or a group of posters through choices based on any combination of 
Category/Style, Color, Artist, Size or Subject.    The results of these searches can viewed at any time 
or saved as a file for future reference. Any previously saved Image Search file can be reactivated and 
edited through the Image Search dialog.

Move between selection criteria by clicking on one of the tabs for Category/Style, Color, Artist, Size or 
Subject.

The Image Search is activated every time a criteria is selected.    The number of current matches based 
on the selected criteria is indicated beneath the tabs on the Image Search window

The Show Matches button displays the selected posters as thumbnails in the browser window.

The Clear Search button clears all previously selected criteria.

After reviewing the results, an Image Search can be saved as a file by selecting Image Search from the 
pull down menu at the top of the screen and choosing Save Image Search, naming the file in the space 
provided.



How to Edit an Existing Image Search

Select a saved Image Search file by selecting it either through the File Menu or the Image Search menu. 
Editing the file is done through modifying any of the existing selection criteria such Category/Style, 
Color, Artist, Size or Subject.    The results of these searches can resaved as a file for future reference. 

Move between selection criteria by clicking on one of the tabs for Category/Style, Color, Artist, Size or 
Subject.

The Show Matches button displays the selected posters as thumbnails in the browser window.

The Clear Search button clears all previously selected criteria.



How to create a Slide Show

Add selected images to the shopping cart using the Add Button.    When all desired images are selected, 
select Slide Show from the pull down menu and choose Save Order as Slide Show.    Name the slide 
show for future use. 



How to create an Order

Add selected images to the shopping cart using the Add Button.    After selecting each work a dialog will 
appear requesting the quantity desired.    The Order can be reviewed by pressing the Shopping Cart 
Button.    Additional editing options such as delete or edit order are available from the shopping cart 
dialog.    The order can then be saved and/or printed.



How to print an Order

An Order can be printed from the Shopping Cart Dialog by pressing the Print Button. 



Index command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Image Search and various types of reference information. 

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of Image Search.



Context Help command 

Use the Context Help command to obtain help on some portion of Image Search.    When you choose the 
Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.    Then click 
somewhere in the Image Search window, such as another Toolbar button.    The Help topic will be shown 
for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the scroll bars 
indicate your vertical and horizontal location in the document.    You can use the mouse to scroll to other 
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the 
border you want to move. 

2. Press a DIRECTION key to move the border.

3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with 
the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Image Search window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Image Search determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Image Search determines which 
window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the document 
Control menu closes only one window at a time.    You can close all windows at once with the Close 
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or 
Minimize command.



Clear command (Edit menu)

<< Write application-specific help here. >>



Clear All command (Edit menu)

<< Write application-specific help here. >>



Modifying the Document

<< Write application-specific help here that provides an overview of how the user should modify a 
document using your application. 

If your application supports multiple document types and you want to have a distinct help topic for each, 
then use the help context i.d. generated by running the MAKEHELP.BAT file produced by AppWizard.    
Alternatively, run MAKEHM as follows:

makehm IDR_HIDR_,0x2000 resource.h

If the IDR_ symbol for one of your document types is, for example, IDR_CHARTTYPE, then the help 
context i.d. generated by MAKEHM will be HIDR_CHARTTYPE.

Note, AppWizard defines the HIDR_DOC1TYPE help context i.d. used by this help topic for the first 
document type supported by your application.    AppWizard produces an alias in the .HPJ file for your 
application, mapping HIDR_DOC1TYPE to the HIDR_ produced by MAKEHM for that document type. >>



Category/Style Dialog

This dialog allows selection through the Image Search of posters by any one or group of categories or 
styles.    Category/Styles marked with a blue box to the left of the text can be expanded by double clicking 
to reveal sub categories.    Select desired category/styles by clicking once on the desired item.    Any 
selected item will be highlighted.    Clicking on one of the larger categories automatically includes all sub 
categories.    More than one category/style can be selected simultaneously.

Selected Category/Styles can be deselected by clicking once more on the highlighted item.

Also available through this dialog is the ability to filter by medium, or by publisher/collection.



Colors Dialog

By default all color palettes are selected, however, specific color palettes can be selected either 
individually or collectively by checking the appropriate boxes.    Note that when an individual color is first 
selected, the all colors palette radio button is automatically turned off.



Subjects Dialog

Subjects can be selected by highlighting the desired item in the Available Subjects window, and then 
pressing the add button at the bottom of the dialog.    Subjects marked with a blue box to the left of the 
text can be expanded by double clicking to reveal sub categories.    Clicking on one of the larger subjects 
automatically includes all subjects attached beneath it.    After pressing the add button, the selection also 
appears in the Selected Subjects window.    Selected subjects can be removed by highlighting the desired 
item and pressing the remove button.

Subjects marked with an asterisk are part of an abbreviated list of commonly selected items.    This short 
list can be displayed by checking the box for Special Bruce McGaw Graphics Subject Short List. At the 
bottom of the Subjects window.



Sizes Dialog

There are many ways to narrow the selection criteria based on size.    The default selection is set to all 
sizes.

If Standard Sizes is selected, the dialog window displays all of the standard sizes available.    One or 
several specific sizes can then be selected.

If Specify Range is selected, fill in the width and height of the posters desired and specify a tolerance.    
Size can be based on either the image size or the paper size.by clicking on the appropriate selection.

Poster Packs are conveniently sized poster/package combinations that allow easy mailing.    Size can be 
limited to one or more formats.

Poster selections can also be filtered by either horizontal or vertical format.    In addition, units can be 
changed to either metric or imperial scales by making the appropriate selection.



Artists Dialog

Artists can be another criteria for selecting posters in the Image Search.    The artists are listed in 
alphabetical order, and can be selected by highlighting the appropriate name in the Available Artists 
window, and then pressing the add button at the bottom of the dialog.    After pressing the add button, the 
selection also appears in the Selected Artists window.    Selected Artists can be removed by highlighting 
the desired item and pressing the remove button.

If previous criteria have been selected, only the artists that match that criteria will be displayed.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the AFX_HIDP_xxx 
values from the [ALIAS] section of your .HPJ file, and author a topic for each AFX_HIDP_xxx value.    For 
example, AFX_HIDP_INVALID_FILENAME is the help topic for the Invalid Filename message box. >>



Thumbnail Screen

Each of the items selected from an Image Search are displayed in groups of eight along with the title, 
artist, and catalog number.    The number of matches from the Image Search is indicated at the lower 
center of the screen.

Navigation is through the arrow bars at the bottom of the screen.    These include from left to right:
Go to the first set of images of the Image Search results
Step back to the last eight images
Step forward to the next eight images
Go to the last set of eight images

To see a larger version of the image and to obtain more information about the poster, click on the desired 
image.



Poster Information Screen

This is the basic information screen for the selected poster.    From here it is possible to view a full screen 
image of the poster, view the artists biography, and navigate forward and backward through the results of 
the Image Search.

Clicking on the image will display a full screen version of the poster on a black background.    Return to 
the Poster Information Screen by either clicking on the image again or by pressing the Escape key.

It is also possible to add the image to the shopping cart by clicking on the add button on the toolbar.    The 
program will then ask for the quantity desired, and will add them to the shopping cart.



Full Screen Image

A full screen image of the poster is displayed with a black background.    Return to the Poster Information 
Screen by clicking on the image or pressing the Escape key



Shopping Cart Screen

Items designated for the shopping cart are listed along with the quantity, catalog number, and price.

The contents of the cart can be viewed individually, edited, deleted, saved for future reference, or be 
printed as a Bruce McGaw Graphics Order Form.

Edit or change any item in the cart by clicking on the item and then clicking on the appropriate button on 
the right side of the screen.

Background information used in creating the Order Form such as pricing, can be edited through the Edit 
Preferences command on the top pull down menu.



Edit Preferences

Name & Address:
This information is used to personalize the Order Form

Pricing:
Controls the prices displayed both on the information screens as well as the order form.    Prices can be 
displayed as the standard prices from the catalog, or can be factored with either a discount or markup.

International:
Controls the size measurements used within the Browser (either Metric or Imperial) as well as the 
currency used for pricing information.







Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where you may 
specify the range of pages to be printed, the number of copies, the destination printer, and other printer 
setup options.

Shortcuts
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection.    Choose the Setup option to change the printer and 
printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:

All Prints the entire document.
Selection Prints the currently selected text.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the printer.    The 
page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When you choose 
this command, the main window will be replaced with a print preview window in which one or two pages 
will be displayed in their printed format.    The print preview toolbar offers you options to view either one or 
two pages at a time; move back and forth through the document; zoom in and out of pages; and initiate a 
print job.



Print Preview toolbar

The print preview toolbar offers you the following options:

Print
Bring up the print dialog box, to start a print job.

Next Page
Preview the next printed page.

Prev Page
Preview the previous printed page.

One Page / Two Page
Preview one or two printed pages at a time.

Zoom In
Take a closer look at the printed page.

Zoom Out
Take a larger look at the printed page.

Close
Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a Print Setup 
dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use.    Choose the Default Printer; or choose the Specific Printer option 
and select one of the current installed printers shown in the box.    You install printers and configure 
ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to the type of 
printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>




